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About this Guide

Conventions Used in this Guide

Text

The following list describes conventions that are used in this guide to differentiate types of text:

• Blue text indicates one of the following:

• A note, if a notepad and pencil icon  precedes it

• A cross-reference that is linked to another section within this guide

• Bold text indicates:

• One or more words that you have to type, if it is also in Courier

• Features on the tabbed pages

• Courier text indicates one or more words that you have to type, if it is also Bold.

• Italicized text indicates:

• A reference to another guide or to a CD

• Feature options

• An arrow (→) combines one or more actions into one step.

Icons

This icon indicates that you should follow the information carefully to avoid prob-
lems or errors.

This icon indicates that helpful information follows.

This icon indicates that a helpful tip on how to use the software or hardware follows.
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Section 1   Overview
The Print File Downloader is a utility that provides a way to print Adobe PostScript (PS), Adobe Portable 
Document Format (PDF), PCL (Windows only), and TIFF Group 4 Compressed print-ready files.

The features of the Print File Downloader include:

• Compatibility with multiple Printers and Print Server software

• Ability to download PostScript, PDF, PCL, and TIFF Group 4 Compressed print-ready files

• Ability to save and use job settings files

After you create a print-ready file using any application compatible with Windows 9x, Windows Me 
(Millennium Edition), Windows 2000, Windows NT, or Macintosh systems, you can use the Print File 
Downloader to print on one of the supported Printers.

You can select a single file or multiple files to print using the Print File Downloader. The Printer treats 
multiple files as separate jobs when they are sent to the Printer. The Print File Downloader allows you to 
specify printing options such as stapling, collation, paper substitutions, and printing in pamphlet mode, 
depending on the selected Printer. Some Printers do not support all of the features. You can use the Print 
File Downloader to improve the compatibility of certain document creation applications and Printers.

How Does the Print File Downloader Work?

The Print File Downloader enables Printer features by attaching a header to a print-ready file. The header 
contains DSC and KDK comments. These DSC and KDK comments usually override printer language 
commands within the original print-ready file. See the “Glossary” for more information. The Printer 
interprets printer language commands and DSC and KDK comments according to the following 
guidelines:

• The Print File Downloader does not read or parse selected print-ready files.

• If selected print-ready files contain more than one header or existing DSC and KDK comments, the 
Printer interprets the first specific DSC or KDK comment encountered.

• You can verify the DSC and KDK comments by enabling the Status Page feature and checking the 
comments listed on the printed status page.

Printing Features

The Print File Downloader allows you to select options from the standard printing features that Printers 
offer. These features, some of which are listed in Table 1-1, allow you to control job setup and document 
finishing.

The Print File Downloader is not a Printer Driver. It has only downloading capability. Use 
the Print File Downloader after you create your print-ready files using one of the standard 
compatible Printer Drivers listed in “Compatible Printer Drivers” on page 1-5.

Some Printers do not support all of the features. The unsupported features of the selected 
Printer will be grayed out and unselectable.
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Overview
Table 1-1  Printer Model Feature Support

Feature Value
Network 
Imaging 
System

Other 
Printer

Print Deselected � �

Selected � �

Create TIFF Deselected � �

Selected � �

User Name Text Input � �

Save As Deselected � �

Selected � �

Text Input � �

Specific Printer Deselected � �

Selected �

Text Input � �

List Files of Type Adobe PostScript � �

PCL � �

Print � �

Adobe PDF � �

TIFF Group 4 
Compressed

� �

Copies 1 to 99999 � �

Print Range All � �

To � �

From: � �

Printing Mode One-Sided � �

Two-Sided 
Flip on Long Edge

� �

Two-Sided 
Flip on Short Edge

� �

Interleaves - Blank � �

Interleaves - Printed � �

Pamphlets � �

Body Paper Paper Name � �
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Overview
Collate Deselected � �

Selected � �

Chapter Pages Page List � �

Finish Chapters 
Separately

Deselected � �

Selected � �

Exit Booklet Maker �

Stacker � �

Stapler �

Top Exit � �

Other Finisher � �

Trim Edges Deselected �

Selected �

Stacking Offset � �

Straight � �

Stapling None � �

Top � �

Bottom � �

2 on Edge � �

Saddle Stitch � �

Folding None � �

Saddle Fold � �

Front Cover None � �

Print Side 1 � �

Print Side 2 � �

Print Both Sides � �

Preprinted/Blank � �

Front Cover Paper Paper Name � �

Feature Value
Network 
Imaging 
System

Other 
Printer
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Overview
Back Cover None � �

Print Side 1 � �

Print Side 2 � �

Print Both Sides � �

Preprinted/Blank � �

Back Cover Paper Paper Name � �

Pamphlet Cover None � �

Print Both Sides � �

Preprinted/Blank � �

Pamphlet Cover Paper Paper Name � �

Print Proof Set Deselected � �

Selected � �

Inserter Support Deselected � �

Selected � �

Mismatch Handling Notify then Wait � �

Set Separators Deselected � �

Selected � �

Set Separators Paper Paper Name � �

Status Pages Mode None � �

Always � �

Only On Error � �

Always - 
1st Page Only

� �

Status Pages Paper Paper Name � �

Operator Message Text Input � �

Deliver To Text Input � �

Charge Number Text Input � �

E-Mail Notification Text Input �

Prepend Deselected � �

Selected � �

Feature Value
Network 
Imaging 
System

Other 
Printer
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Overview
Compatible Printer Drivers

PostScript Files

You should only use the following Printer Drivers to print PostScript print-ready files using the Print File 
Downloader. For most of the supported Printers, PostScript Printer Definition files (PPDs) are available. 
When you create PostScript print-ready files, you should only use the included PPDs.

Table 1-2  Compatible Printer Drivers for PostScript files

PCL Files

You should only use the following Printer Drivers to print PCL print-ready files using the Print File 
Downloader. These Printer Drivers are only for Windows systems:

• Hewlett-Packard® LaserJet® 6P

• Hewlett-Packard LaserJet 4SiMX

• Hewlett-Packard DeskJet 1200C (set at 600 dpi)

Postpend Deselected � �

Selected � �

Remove CTRL+D 
Characters Before and 
After Print Job

Deselected � �

Selected � �

Compile Only - Do Not 
Print Job

Deselected � �

Selected � �

Operating System Printer Driver

Windows 9x and Windows Me AdobePS 4.3.1

Windows NT 4.0 AdobePS 5.12

Windows 2000 Standard Windows 2000 PostScript Driver
with Service Pack 1 or later

Macintosh 8.6 to 9.1 AdobePS 8.7.x
LaserWriter® 8.7.x

Feature Value
Network 
Imaging 
System

Other 
Printer
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Job Settings Files

You can create, save, and reuse individual job settings files. For example, you might create and save one 
job settings file for two-sided, stapled print jobs with covers; a second file for single-sided, three hole 
print jobs; and a third file for a document that has several pages printed on red paper. If you print a 
document using one of these settings files, you can use it to print that document again at a later time, or 
you can use a combination of the settings files to print a different document.

Supported File Formats

The Print File Downloader supports the following print-ready file formats:

• Adobe PostScript 3 or earlier

• Adobe PDF

• TIFF CCITT G4

• PCL 4

• PCL 5

• PCL XL

The Print File Downloader does not support the following print-ready file formats:

• imPRESS 

• Lineprinter

A new version of the Print File Downloader will open an older settings file and prompt you 
to save it.

Only Windows systems support PCL files.
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Section 2   Installing and Configuring the Print File 
Downloader

This section lists the requirements and provides the installation and configuration procedures for the Print 
File Downloader. You should be familiar with your Windows or Macintosh system in order to perform 
the installation.

You should install a copy of the Print File Downloader on each computer system that will use the Print 
File Downloader. You cannot run the Print File Downloader from a shared server or in any environment 
where multiple users would access the software.

Hardware Requirements

Windows Systems

Windows systems require the following hardware:

• 233 MHz Pentium® processor

• 64 MB of RAM

• 5 MB of available Hard Drive space (minimum) plus free disk space to equal the size of the file you 
want to print

• Monitor (800 x 600 pixel with 24-bit color depth)

Macintosh Systems

Macintosh systems require the following hardware:

• PowerPC 601 processor

• 16 MB of RAM

• 5 MB of available Hard Drive space (minimum) plus free disk space to equal the size of the file you 
want to print

• 800 x 600 Monitor with 256 colors

For Windows 9x or Windows Me systems, you should have already loaded the Adobe Post-
Script 4.3.1 Printer Driver. You must install that Printer Driver before installing the Print 
File Downloader. Refer to the Adobe documentation or follow the online instructions to 
complete this installation.

For Windows NT 4.0, if you do not want to use the standard NT PostScript Printer Driver, 
you must use the AdobePS 5.1.2 Printer Driver.

You can copy the contents of the Printer Drivers, PPD Files, and Print File Downloader 
Software CD to a server and then follow the installation instructions to load the software on 
each system.
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Installing and Configuring the Print File Downloader
Software Requirements

Windows Systems

Your Windows system must use one of the following Microsoft operating systems:

• Windows 9x 

• Windows Me

• Windows 2000 with Service Pack 1 or higher

• Windows NT, version 4.0, with service pack 5 or higher

Macintosh Systems

Your Macintosh system must use a MacOS version from 8.6 to 9.1.

Installing the Software

Installing the Software on a Windows System

On Windows systems, you must specify a printer to which to send the print jobs. You can add a printer 
using the Add Printer feature of the Printer Control Panel.

To install the Print File Downloader on a Windows system:

This procedure assumes your system is on and the operating system is loaded. It also assumes you have 
a zip program installed on your system.

  1. Close all open applications.

  2. If you are using the CD to install the Print File Downloader, insert the Printer Drivers, PPD Files, 
and Print File Downloader Software CD into the CD-ROM Drive. If you are using any other 
source to install the Print File Downloader, save the .zip file to a folder on your hard drive, and 
continue to step 13.

  3. Double-click My Computer.

The My Computer window appears.

  4. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  5. Double-click Start_xxxx.htm.

A web browser appears.

  6. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  7. Scroll down to the Print File Downloader row and click Windows.

You can verify the NT version and service pack from the blue screen that appears when you 
start up your system.

Verify with your Windows administrator that you have the appropriate privileges to install 
the Print File Downloader software.
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Installing and Configuring the Print File Downloader
The File Download window appears.

  8. Select “Save this file to disk.”

  9. Click OK.

The Save As window appears.

10. Select a folder in which to save the PFD_W9MN2_xx.zip file.

11. Click Save.

The Download Complete window may appear. If this window appears, click Close.

12. Close the web browser.

13. Navigate to the folder into which you saved the .zip file. If you used another source to download the 
files, double-click My Computer, and then navigate to the folder into which you saved the file.

14. Double-click PFD_W9MN2_xx.zip.

A window appears displaying the contents of the .zip file.

15. Extract the files to a folder on your hard drive.

16. Close the zip program.

17. Navigate to the folder into which you extracted the files.

18. Double-click Setup.exe.

19. Follow the instructions on the screen to complete the installation.

20. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary.

Installing the Software on a Macintosh System

To install the Print File Downloader on a Macintosh system:

This procedure assumes the Stuffit program is installed on your system.

  1. Close all open applications.

  2. If you are using the CD to install the Print File Downloader, insert the Printer Drivers, PPD Files, 
and Print File Downloader Software CD into the CD-ROM Drive. If you are using any other 
source to install the Print File Downloader, save the file to a folder on your hard drive, and continue 
to step 10.

  3. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  4. Double-click Start_xxxx.htm.

A web browser appears.

If you have a previous version of the Print File Downloader installed on your system, you 
must delete the Print File Downloader PWPrefs, Print File Downloader Prefs, and Print 
File Downloader DirPrefs files from the Systems → Preferences folder before launching 
the Print File Downloader for the first time after installation. See “To uninstall the Print File 
Downloader on a Macintosh system using the drag-and-drop method:” on page 2-12.
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  5. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  6. Scroll down to the Print File Downloader row and click Mac OS.

A window appears indicating to save the document.

  7. Navigate to a location in which to save the file.

  8. Click Save.

The download is complete when the status bar disappears.

  9. Close the web browser.

10. Navigate to the folder into which you saved the .hqx file. If you used another source to download 
the files, double-click Start-Up Disk, and then navigate to the folder into which you saved the file.

11. Double-click PFD_MA89_xx.hqx.

The Save window appears.

12. Save the files to a folder on your hard drive.

13. Close the Stuffit program.

14. Navigate to the folder into which you extracted the files.

15. Double-click xxxx PFD Installer.

16. Follow the instructions on the screen to complete the installation.

17. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary. 

Cancelling an Installation in Progress (Windows only)

You can only cancel an installation in progress on Windows systems. This option is not available on 
Macintosh systems.

To cancel an installation in progress:

  1. Click Cancel or press [ESC].

The confirmation window appears.

  2. Click Exit Setup to end the installation.

If you terminate the installation while files are being copied, the files already copied will 
not be removed. However, if you had a previous version installed, some of the files will be 
overwritten and the Print File Downloader will no longer function.
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Uninstalling the Print File Downloader

Uninstalling the Print File Downloader on Windows Systems

To uninstall the Print File Downloader on a Windows system:

  1. Click Start → Setting → Control Panel.  

The Control Panel window appears.

  2. Double-click Add/Remove Programs.

The Add/Remove Programs Properties window appears. For Windows 2000, the Add/Remove 
Programs window appears.

  3. Select the Print File Downloader from the list.

  4. Click Add/Remove. For Windows 2000, click Change/Remove.

The Confirm File Deletion window appears.

  5. Click Yes.

Uninstalling the Print File Downloader on Macintosh Systems

To uninstall the Print File Downloader on a Macintosh system using the uninstaller:

  1. From your hard drive, navigate to the PFD Installer.

  2. Double-click PFD Installer.

The Installer window appears.

  3. Click Continue.

The License window appears.

  4. Click Accept.

The PFD Installer window appears.

  5. From the Easy Install drop-down menu, select Uninstall.

  6. From the Install Location drop-down menu, select Select Folder.

A window appears that allows you to select the folder where the Print File Downloader is located.

  7. Navigate to the folder where the Print File Downloader is located.

  8. Click Select.

  9. Click Uninstall.

A message appears indicating that no other applications should be running.

10. Click Continue.

A message appears indicating the uninstall was successful.

11. Click OK.
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To uninstall the Print File Downloader on a Macintosh system using the drag-and-drop 
method:

  1. Drag the Print File Downloader to the trash.

  2. Double-click your hard drive icon.

  3. Double-click System folder.

  4. Double-click Preferences.

  5. Drag the Print File Downloader PWPrefs, Print File Downloader Prefs, and Print File 
Downloader DirPrefs files to the trash.

Installing the Print File Downloader PPD Files

If you create PostScript print-ready files to use with the Print File Downloader, you should install the 
PPD files included with the Print File Downloader. These PPD files are specifically for use with the Print 
File Downloader, and are in addition to the regular PPD files you may have already installed. You should 
install the Print File Downloader PPD files for the Printers that you will be using.

The Print File Downloader PPD files are not meant to print to real Printers. They are used with your 
application to create a “Print to File” document which will be printed from the Print File Downloader.

If a previous version of the currently supplied Print File Downloader PPD file is already installed on your 
system, you must delete it before you install the new PPD files.

Installing the Print File Downloader PPD Files on Windows Systems

To install the Print File Downloader PPD files on a Windows 9x or Windows Me system:

You must use the Print File Downloader PPD file in conjunction with the Adobe PostScript Printer Driver, 
version 4.3.1.

  1. Close all open applications.

  2. If you are using the CD to install the Adobe PostScript PPD file for the Print File Downloader, 
insert the Printer Drivers, PPD Files, and Print File Downloader Software CD into the CD-ROM 
Drive. If you are using any other source to install the Adobe PostScript PPD file for the Print File 
Downloader, save the file to a folder on your hard drive, and continue to step 13.

  3. Double-click My Computer.

The My Computer window appears.

  4. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  5. Double-click Start_xxxx.htm.

A web browser appears.

  6. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  7. Scroll down to the Adobe PostScript PPD for the Print File Downloader row and click Win9x & 
Me.

The File Download window appears.

  8. Select “Save this file to disk.”

  9. Click OK.
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The Save As window appears.

10. Select a folder in which to save the PPDFD_W9x_xx.zip file.

11. Click Save.

The Download Complete window may appear. If this window appears, click Close.

12. Close the web browser.

13. Navigate to the folder into which you saved the .zip file. If you used another source to download the 
files, double-click My Computer, and then navigate to the folder into which you saved the file.

14. Double-click PPDFD_W9x_xx.zip.

A window appears displaying the contents of the .zip file.

15. Extract the files to a folder on your hard drive.

16. Close the zip program.

17. Navigate to the folder into which you extracted the files.

18. Double-click the Setup folder.

19. Double-click Setup.exe.

20. Follow the instructions on the screen to complete the installation.

21. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary.

To install the Print File Downloader PPD files on a Windows NT 4.0 system:

  1. Close all open applications.

  2. If you are using the CD to install the Adobe PostScript PPD file for the Print File Downloader, 
insert the Printer Drivers, PPD Files, and Print File Downloader Software CD into the CD-ROM 
Drive. If you are using any other source to install the Adobe PostScript PPD file for the Print File 
Downloader, save the file to a folder on your hard drive, and continue to step 13.

  3. Double-click My Computer.

The My Computer window appears.

  4. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  5. Double-click Start_xxxx.htm.

A web browser appears.

  6. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  7. Scroll down to the Adobe PostScript PPD for the Print File Downloader row and click WinNT.

The File Download window appears.

  8. Select “Save this file to disk.”

  9. Click OK.

The Save As window appears.

10. Select a folder in which to save the PPDFD_WNT_xx.zip file.

11. Click Save.
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The Download Complete window may appear. If this window appears, click Close.

12. Close the web browser.

13. Navigate to the folder into which you saved the .zip file. If you used another source to download the 
files, double-click My Computer, and then navigate to the folder into which you saved the file.

14. Double-click PPDFD_WNT_xx.zip.

A window appears displaying the contents of the .zip file.

15. Extract the files to a folder on your hard drive.

16. Close the zip program.

17. Navigate to the folder into which you extracted the files.

18. Double-click the Setup folder.

19. Double-click Setup.exe.

20. Follow the instructions on the screen to complete the installation.

21. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary.

To install the Print File Downloader PPD files on a Windows 2000 system:

  1. Close all open applications.

  2. If you are using the CD to install the Adobe PostScript PPD file for the Print File Downloader, 
insert the Printer Drivers, PPD Files, and Print File Downloader Software CD into the CD-ROM 
Drive. If you are using any other source to install the Adobe PostScript PPD file for the Print File 
Downloader, save the file to a folder on your hard drive, and continue to step 13.

  3. Double-click My Computer.

The My Computer window appears.

  4. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  5. Double-click Start_xxxx.htm.

A web browser appears.

  6. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  7. Scroll down to the Adobe PostScript PPD for the Print File Downloader row and click Win2000.

The File Download window appears.

  8. Select “Save this file to disk.”

  9. Click OK.

The Save As window appears.

10. Select a folder in which to save the PPDFD_W2K_xx.zip file.

11. Click Save.

You must run the Adobe PostScript Printer Driver executable every time you want to install 
a new Printer.
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The Download Complete window may appear. If this window appears, click Close.

12. Close the web browser.

13. Navigate to the folder into which you saved the .zip file. If you used another source to download the 
files, double-click My Computer, and then navigate to the folder into which you saved the file.

14. Double-click PPDFD_W2K_xx.zip.

A window appears displaying the contents of the .zip file.

15. Extract the files to a folder on your hard drive.

16. Close the zip program.

17. Select Start → Settings → Printers.

The Printers window appears.

18. Double-click Add Printer.

The Add Printer Wizard window appears.

19. Follow the instructions on the screen to complete the installation.

20. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary.

Installing the Print File Downloader PPD Files on Macintosh Systems

To install the Print File Downloader PPD files on a Macintosh system:

  1. Close all open applications.

  2. If you are using the CD to install the Adobe PostScript PPD file for the Print File Downloader, 
insert the Printer Drivers, PPD Files, and Print File Downloader Software CD into the CD-ROM 
Drive. If you are using any other source to install the Adobe PostScript PPD file for the Print File 
Downloader, save the file to a folder on your hard drive, and continue to step 9.

  3. Double-click the CD-ROM Drive icon.

The <CD-ROM Drive> window appears and displays the contents of the CD.

  4. Double-click Start_xxxx.htm.

A web browser appears.

  5. Read the instructions on the screen regarding the contents of the CD and instructions on how to 
extract the files.

  6. Scroll down to the Adobe PostScript PPD for the Print File Downloader row and click Mac OS.

A window appears indicating to save the document.

  7. Click Save.

The download is complete when the status bar disappears.

  8. Close the web browser.

  9. Navigate to the folder into which you saved the .hqx file. If you used another source to download 
the files, double-click Start-Up Disk, and then navigate to the folder into which you saved the file.

You must run the Adobe PostScript Printer Driver executable every time you want to install 
a new instance of a Printer.
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10. Double-click PPDFD_MA89_xx.hqx.

The Save window appears.

11. Save the files to a folder on your hard drive.

12. Close the Stuffit program.

13. Navigate to the folder into which you extracted the files.

14. Double-click xxxx PPD Installer.

15. Follow the instructions on the screen to complete the installation.

16. Remove the Printer Drivers, PPD Files, and Print File Downloader Software CD from the CD-
ROM Drive, if necessary.
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Section 3   Using the Print File Downloader
This section describes how to print using the Print File Downloader. The instructions provided in this 
section and the rest of this guide refer to all systems, including Windows 9x, Windows Me, Windows 
2000, Windows NT, and Macintosh, unless otherwise noted.

Starting the Print File Downloader

To start the Print File Downloader on a Windows system:

  1. Select Start → Programs → <Vendor Name> → <Printer Model Name> Print File Downloader. 

The Print File Downloader opens.

To start the Print File Downloader on a Macintosh system:

  1. Double-click the Print File Downloader icon. 

The Print File Downloader opens. 

Describing the User Interface

Menu Options

File Menu

The following options appear on the File menu:

New—(Windows systems) Resets all settings to the initial settings.  If you did not save your changes, a 
window will appear prompting you to save the settings.

New—(Macintosh systems) Opens a new Print File Downloader window with initial settings.

Open—Opens an existing job settings file.

Close—(Windows systems) Closes the current document and ends the active Print File Downloader 
session. A window will appear verifying that you want to close the window and prompts you to save your 
changes, if necessary.

Close—(Macintosh systems) Closes the current document window, but not the Print File Downloader 
session. Before it closes, it prompts you to save your changes, if necessary.

Save—Saves changes to the current job settings file.

Save As—Saves the job settings file under a new name.

Revert—(Macintosh systems) Returns the job settings file to its original state and discards changes.

Exit—(Windows systems) Closes the current document and ends the active Print File Downloader session. 
A window will appear verifying that you want to close the window and prompts you to save your changes, 
if necessary.

Saved documents contain all settings except the Files to Print selections on the Files tabbed 
page and the printer queue on the Printers tabbed page.

If “Untitled” or “Initial” appears in the title bar of the Print File Downloader window, 
selecting Save will display the Save As window.
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Quit—(Macintosh systems) Closes the current document and ends the active Print File Downloader 
session. Before the window closes, you will be prompted to save your changes, if necessary.

Edit Menu

The following options appear on the Edit menu:

Undo—Dismisses the previous action. If it is not possible to undo the previous action, Can’t Undo appears 
on the Edit menu.

Redo—Dismisses the undo.

Cut—Removes the selected text and saves it temporarily so that it can be inserted elsewhere or discarded.

Copy—Reproduces the selected text and saves it temporarily so that it can be inserted elsewhere.

Paste—Inserts cut or copied text.

Clear—Deletes the selected text.

Refresh—(Windows systems) Updates the tabbed pages with new folders, files, etc.

Catalog Menu

The following options appear on the Catalog menu:

Open Catalog—Opens the list of paper types available in the Paper Catalog for selecting the Body Paper 
and Paper Substitutions.

Change password—Changes or disables the password that accesses the Paper Catalog. You must know 
the password in order to change or disable it.

Window Menu

The following option appears on the Window menu:

Show Clipboard—(Macintosh systems) Opens the Macintosh Clipboard. It also allows you to toggle 
between the open Print File Downloader files.

Help Menu

The following options appear on the Help menu:

Help—Accesses the Print File Downloader online help.

About—(Windows systems) Displays the version and copyright information.

You can also access the online help by pressing [F1] on Windows systems or by clicking the 
Help button that appears on each of the Print File Downloader tabbed pages.

On Macintosh systems, version and copyright information is located on the Apple menu.
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Creating Custom Settings Files

This section provides a list of Print File Downloader tabbed options pages and their descriptions. To create 
a custom settings file, you must set features on these tabbed pages.

Using the Printers Tabbed Page

The Printers tabbed page allows you to select a Printer or Printer port (on Windows systems) for the Print 
File Downloader to use, and to indicate which Printer type you are using. You can also choose to send 
your print request to a Network Imaging System Print Server queue for printing, store it on the Print 
Server for later use, or both.

The following is a list of features on the Printers tabbed page:

Installed Printers—(Windows systems) Allows you to select a Printer from the list of Printers that are 
installed through the Windows system Printer facilities.

Add Network Printer (Windows NT systems only)—Allows you to specify a Printer to use with the 
Print File Downloader.

AppleTalk Zones—(Macintosh systems) Lists the available AppleTalk zones when AppleTalk is active.

Select a Printer—(Macintosh systems) Lists the available Printers.

Rescan Network—(Macintosh systems) Scans the network for zones and devices on the selected zone 
and updates the entries in the list.

Print Server—Sets Print Server storage and queueing options. You can choose to print the job, store a 
copy of the file on the server for future use, or both.

Print—Prints the document through the Print Server.

Create TIFF—When selected, the document will be processed and stored in the Document Library 
without being printed.

Save As—Saves the document as a PostScript, PDF, or PCL language file (Windows systems only) 
and stores it on the Print Server.

If you want to store a document on the Print Server, you must specify a name for the file.

You can enter up to 31 characters in the Save As field. All keyboard characters are valid except for 
! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

If you specify a Print Range for a document, Save As will save the entire document, not just the 
pages in the Print Range.

To add a network Printer on a Windows 9x or Windows Me system, select Start → Settings  
→ Printers, and double-click Add Printer.

The Print and Create TIFF check boxes cannot be selected at the same time. Print is selected 
by default.

If you save a file on the Print Server and a file with the same name is already stored on 
the Print Server, the new file will overwrite the stored file.
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Specific Printer—Causes the Print Server to queue the job to a Printer that you specify. The 
document may print on another Printer if the specified Printer is not installed on the selected Print 
Server.

You can enter up to 31 characters in the Specific Printer field. All keyboard characters are valid 
except for ! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

Enable Printing Options for Printer Model—Indicates the Printer to which you are printing.

If you are using another Printer, select Other. When printing to the Other Printer, the selections that you 
make may not be available. You can also select Other if you do not know the model of the Printer you 
are using.

Using the Files Tabbed Page

The Files tabbed page allows you to choose the files you want to print and to select certain Print File 
Downloader functions.

The following is a list of features on the Files tabbed page:

Directories—(Windows systems) Displays the list of drives and directories from which you can choose. 
Double-click a drive or directory icon to view its contents.

Select Files to Print—Allows you to locate and select the files you want to print. You can only select 
Adobe PostScript, Adobe PDF, Print, PCL (Windows systems only), or TIFF Group 4 Compressed 
(Windows systems only) files. You may select a file by clicking on the file and clicking Select, or by 
double-clicking on the file. Once the file is selected, it appears in the Files to Print list.

List Files of Type—Specifies the type of files to be displayed in the Select Files to Print list.

Eject—(Macintosh systems) Allows you to eject a disk or CD from a disk or CD-ROM Drive.

Desktop—(Macintosh systems) Navigates immediately to the files on the desktop.

Select—Moves the selected file into the Files to Print list.

Select All—Moves all the files in the Select Files to Print list into the Files to Print list.

Files to Print—Displays a list of selected files to print.

Remove—Deletes a selected file from the Files to Print list.

Remove All—Deletes all files from the Files to Print list.

Printer Language—Indicates whether you have selected Adobe PostScript, Adobe PDF, PCL, or TIFF 
Group 4 Compressed files to print.

Modify Print File—Allows you to control the changes that you made to your Adobe PostScript, Adobe 
PDF, PCL, or TIFF Group 4 Compressed files.

Yes—Accesses all of the Printer features based on the printing options on the Printer tabbed page, 
for example, stapling or collating. Control commands are prepended to the existing document file 
to enable the printing features you select.

References to PCL files apply only to Windows systems.

If you select two or more files from the Select Files to Print list, they must be all of the same 
file type. You cannot print different types of files.
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Custom Options Only—Allows you to add custom commands. Only the controls on the Printers, 
Files, Paper Substitutions, and Custom Options tabbed pages will be available.

No—Sends the file to the selected Printer without modification.

Using the Job Setup 1 Tabbed Page

The Job Setup 1 tabbed page allows you to choose common print options for each Printer. 

The following is a list of features on the Job Setup 1 tabbed page:

General Job Properties

Copies—Indicates the number of copies you want.

Print Range—Prints either all pages or a range of pages from your document. When saving documents 
to the Document Library, the whole document is saved, not just the pages specified in the Print Range 
field.

Printing Mode—Allows you to select how you want to print the job.

One-sided—Only prints on one side of the paper.

Two-sided Flip on Long Edge—Prints on both sides of the paper so that you can view the back 
sides by flipping the sheets across their long edges.

Two-sided Flip on Short Edge—Prints on both sides of the paper so that you can view the back 
sides by flipping the sheets across their short edges.

Interleaves - Blank—Inserts a blank sheet of paper between transparency pages when you are 
printing on transparency material. When you select this printing mode, paper substitutions are 
ignored.

Interleaves - Printed—Inserts a sheet of paper between transparency pages that is printed with the 
image that appears on the preceding transparency. When you select this printing mode, paper 
substitutions are ignored.

Pamphlets—Prints output in a book format so that sets can be saddle folded (folded in half) and 
saddle stitched (stapled in the upper and lower center fold). The Printer adds blank pages at the end 
of the document to make a multiple of four pages.

Body Paper—Allows you to select a paper from the Paper Catalog to print the body of the document.

Collate—When selected, all pages of one set print before any pages for the next set print. This check box 
is selected automatically when the Print File Downloader opens.

If you are running the Print File Downloader on a Macintosh system and you select Custom 
Options Only, using the %%Requirements DSC may cause unpredictable results. If 
%%Requirements exists in the original print-ready file, it will be disabled and print 
options such as stapling, folding, offset stacking, and collating may not work.

If this tab is unavailable, check that Modify Print File is set to Yes on the Files tabbed page.

When Printing Mode is set to Pamphlets, the Print File Downloader will ignore the 
1-Sided paper mode setting in the Paper Catalog.
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If Printing Mode is set to Interleaves-Blank, Interleaves-Printed, or Pamphlets, the Collate check box 
is automatically selected when using the Network Imaging System Printer.

Chapter Pages—Indicates document pages that should be printed on the front side of the next sheet of 
paper, even if they would otherwise end up on the back side of the sheet. You can enter up to 1024 
characters in the Chapter Pages field.

The syntax for the Chapter Pages field is described in Table 3-1. Page numbers refer to the actual pages 
and may not relate to the document page numbers.

Finish Chapters Separately—When selected, indicates that the page numbers specified in Chapter Pages 
are set boundaries, with the first page in each set specified by the page number. Finishing options such 
as Stacking, Stapling, and Set Separators are applied individually to each set.

Finishing Setup

Exit—Specifies where the printed output will exit the Printer.

Booklet Maker—Indicates that jobs are sent to the Booklet Maker.

Stacker—Indicates that jobs are sent to the Stacker.

Stapler—Indicates that jobs are sent to the Stapler.

Top Exit—Indicates that jobs are sent to the Top Exit.

You should limit the Chapter Pages entries to numbers, spaces, and periods.

Table 3-1  Syntax for Chapter Pages

Syntax Definition Example

n Indicates a specific page number. 45

n...n Indicates a range of pages. 45...52

n,n
n  n

Indicates more than one page number. 45,52
45  52

...n Indicates a range starting at the first page and 
continuing through to the specified page.

...45

When the Network Imaging System Printer is selected on the Printers tabbed page and 
Printing Mode is set to Two-sided Flip on Long Edge, Two-sided Flip on Short Edge, One-
sided, or Pamphlets, Chapter Pages is enabled.

When the Network Imaging System Printer is selected on the Printers tabbed page and the 
Printing Mode is set to Two-sided Flip on Long Edge, Two-sided Flip on Short Edge, or 
One-sided, Finish Chapters Separately is enabled.

The finishing device must exist on the Printer. If you select a finishing device that is not part 
of your Printer, a message will appear at the Printer indicating that you cannot select that 
device and the Printer will not start.
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Other Finisher—Indicates that jobs are sent to a different finishing device.

Stacking—Specifies if multiple sets of a document are to be delivered with or without a shift between sets.

Straight—Indicates that sets are delivered in a single stack.

Offset—Indicates that sets are delivered in offset stacks.

Stapling—Specifies if (and where) printed sets should be stapled.

None—Indicates that documents are not stapled.

Top—Indicates that portrait documents are stapled in the upper left corner and landscape 
documents are stapled in the upper right corner.

Bottom—Indicates that portrait documents are stapled in the lower left corner and landscape 
documents are stapled in the upper left corner.

2 on Edge—Indicates that portrait documents are stapled near the upper and lower left corners and 
landscape documents are stapled near the left and right corners.

Folding—Specifies if (and how) printed sets should be folded.

None—Indicates that documents are not folded.

Saddle Fold—Indicates that documents are folded in half to be saddle stitched. This setting is 
useful when you are creating finished pamphlets.

Trim Edges—When checked, trims the edges of pamphlets.

Covers

Front Cover—Specifies that your document should have a front cover and whether the cover should be 
printed or blank.

None—Indicates that no front cover prints.

When Exit is set to Other Finisher, Stapling is set to None and disabled.

If Folding is set to Saddle Fold, Stapling is set to Saddle Stitch. You can fold a maximum 
of 22 sheets.

When Exit is set to Other Finisher, Folding is set to None and disabled.

You can only select the Trim Edges check box when the Network Imaging System Printer is 
selected on the Printers tabbed page and when Exit is set to Booklet Maker.

When Exit is set to Other Finisher, Trim Edges is automatically deselected and disabled.

When the Printing Mode is set to an Interleaves option, covers are not available.

When Front Cover or Back Cover is set to Print Side 2 or Print Both Sides, the Printing 
Mode for the corresponding paper cannot be One-sided.
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Print Side 1—Prints the first page of the document on the front side of the selected paper.

Print Side 2—Prints the first page of the document on the back of the selected paper.

Print Both Sides—Prints the first page of the document on the front of the selected paper and the 
second page of the document on the back of the selected paper.

Preprinted/Blank—Places a preprinted or blank sheet of the selected paper at the beginning of the 
document.

Paper—Specifies the paper to be used for the front cover.

Back Cover—Specifies that your document should have a back cover and whether the cover should be 
printed or blank. 

None—Indicates that no back cover prints.

Print Side 1—Prints the last page of the document on the front side of the selected paper.

Print Side 2—Prints the last page of the document on the back side of the selected paper.

Print Both Sides—Prints the second to the last page of the document on the front of the selected 
paper and the last page of the document on the back of the selected paper.

Preprinted/Blank—Places a preprinted or blank sheet of the selected paper at the end of the 
document.

Paper—Specifies the paper to be used for the back cover.

Print Proof Set—When selected, prints a proof set copy of your document.

Inserter Support—When selected, the Inserter is available to the system. The default setting is 
deselected.

Print Side 2 is only available when the Network Imaging System Printer is selected.

Print Side 2 is only available when the Network Imaging System Printer is selected.

Media that supports Inserter mode must be loaded in the Inserter tray. Because the Inserter 
is located after the Fuser, this paper will never be printed on.
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Using the Job Setup 2 Tabbed Page

The Job Setup 2 tabbed page allows you to choose common print options for each Printer.

The following is a list of features on the Job Setup 2 tabbed page:

Printer Setup

Mismatch Handling—Specifies the action that you want the Printer to take if a specified paper option 
does not match the paper types available on the Printer.

Notify then Wait—Displays a message describing the mismatch on the Printer console. You must 
intervene in order to continue.

Set Separators—When selected, inserts a sheet of paper between each document set.

Paper—Indicates the paper that will be used for Set Separators.

Status Pages—Specifies whether or not a status page should be printed with the job. Status pages contain 
information about the print job.

None—Indicates that no status pages print.

Only on Error—Indicates that status pages print only if a problem occurs during printing.

Always—Indicates that status pages always print.

Always - 1st Page Only—Indicates that only the first page of the status pages prints.

Paper—Indicates the paper that will be used for status pages.

Maximum Signature Size - Pages—Allows you to specify the maximum number of physical sheets of 
paper to print within a signature or booklet (pamphlet). This feature is enabled only when Printing Mode 
is set to Pamphlets on the Job Setup 1 tabbed page.

You can print four pages on a single sheet of paper. The Printer will produce multiple pamphlets if the 
number of sheets required exceeds the Printer's maximum capability for finishing (saddle folded and 
saddle stitched). When Exit is set to Booklet Maker, the maximum size is 22 sheets (88 pages) folded and 
stapled.

Sheets—Displays the value entered in the Maximum Signature Size - Pages field, divided by the 
number of pages per sheet (4), rounded up to the next greatest integer.

Mismatch Handling is always set to Notify then Wait.

To enable the Set Separators check box, Stapling must be set to None and the Collate check 
box must be selected.

When Booklet Maker is selected, all papers must have the same paper size value. If the 
paper sizes are not all the same, a warning message will appear indicating you cannot have 
mixed paper sizes when Printing Mode is set to Pamphlets, and printing will not start.
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Other Fields

Operator Message—Allows you to enter a message to print on the job’s header page (for example, “This 
is a RUSH job.”). You can enter up to 80 characters in this field. All keyboard characters are valid except 
for ! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

Deliver To—Allows you to enter a message that tells the operator at the Printer where a job should be 
forwarded. You can enter up to 31 characters in the Deliver To field. All keyboard characters are valid 
except for ! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

Charge Number—Specifies a number assigned by your organization to track printing charges. You can 
enter up to 31 characters in the Charge Number field. All keyboard characters are valid except for
! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

E-Mail Notification—Displays the e-mail address of the person to whom to send the status page 
information. You can enter up to 64 characters in the E-Mail Notification field. All keyboard characters 
are valid except for ! ” % ’ (  ) , / ; < > [ \ ] ^ { | } « ».

Using the Custom Options Tabbed Page

The Custom Options tabbed page allows you to customize your print job by entering printer control 
commands to access specific Printer features.

To use this tabbed page, you must be familiar with PostScript language commands, document structuring 
conventions (DSCs), printer comments, Adobe Portable Document Format (PDF) commands, Print 
Control Language (PCL) commands, and Printer Job Language (PJL) commands.

The following is a list of features on the Custom Options tabbed page:

Custom Commands (Text)—Allows you to enter commands to specify Printer features that you cannot 
directly access through the Print File Downloader. You should enter only valid DSC and KDK statements 
and PostScript or PJL language commands. Since the Print File Downloader does not validate the text 
you enter, if you enter invalid statements, you will have unpredictable printing results. You can enter up 
to 255 characters, including spaces, in the Custom Commands field.  

The entry in the Operator Message field appears on the Printer console and status page.

The entry in the Deliver To field appears on the Printer console of some Printers and the sta-
tus page.

The entry in the Charge Number field appears on the status page. It also appears in the 
Charge Number column of the job accounting file.

If Modify Print File is set to Custom Options Only on the Files tabbed page, and you enter 
commands in the Custom Commands field, the custom commands must include file start 
statements that are appropriate for the Printer model and Printer language being used. For 
more information, see “Modify Print File Header Control” on page 3-12.
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Custom Command Script—Allows you to enter one script file in addition to custom commands. The 
script file must contain valid DSC and KDK statements and/or PostScript or PJL language commands. 
The Print File Downloader does not validate the text in the script file or custom commands, so if you 
enter invalid statements, you will have unpredictable printing results.

File Name—Displays the name of a selected script file. On Windows systems, you can also type the name 
of a script file in the field.

Select File—Opens a window that allows you to select an existing file.

Clear—Removes the entry from the File Name field.

Output Location—Allows you to select the location in which to place custom options in the header.

Prepend—Places custom options at the beginning of the header. 

Postpend—Places custom options at the end of the header.

Remove CTRL+D Characters Before and After Print Job—When selected, removes CTRL+D 
characters occurring before and after the print file. CTRL+D characters that appear in custom scripts or 
in custom commands are not removed.

Compile Only - Do Not Print Job—When selected, the print job compiles at the Printer, but it is not 
printed. If you selected to print status pages on the Job Setup 2 tabbed page, a status page with job 
processing information will print. You can review the status page for possible printing errors.

Printer Command References

Refer to the following publications for information about Printer commands:

• Interface Development Guide, W824

• PostScript Language Reference Manual, Third Edition, (Red Book) (0-201-18127-4), Adobe 
Systems Incorporated (1990)

• Adobe Portable Document Format Reference Manual, Version 1.3, Adobe Systems Incorporated 
(1/00)

• Printer Job Language Technical Reference Manual, Rev. 8, Hewlett-Packard Company (5/96)

If you set Modify Print File to Custom Options Only on the Files tabbed page, and you use 
a custom script but no custom commands in the Custom Commands field, the script must 
begin with file start statements that are appropriate for the Printer model and Printer lan-
guage being used. For more information, see “Modify Print File Header Control” on page 3-
12.

References to PCL files and PJL comments apply only to Windows systems.
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Custom Options Guidelines

Use the following guidelines when entering custom options:

• The Print File Downloader does not check for errors in the text that you enter, so if you enter 
invalid statements, you will have unpredictable printing results.

• All custom options are placed before %%EndComments.

• If both Custom Commands and a selected script file are used in the same print request, the 
commands that are entered in the Custom Commands field are added directly to the print file before 
the contents of the script file, and the script file is placed directly before %%EndComments. If two 
or more similar DSCs or KDKs are included, the Printer uses the first one it encounters.

• If you postpend custom options when Modify Print File is set to Yes on the Files tabbed page, the 
settings you select in the Job Setup tabbed pages will override any DSCs and KDKs on the Custom 
Options tabbed page that correspond to any features that were selected within the Job Setup tabbed 
pages.

Modify Print File Header Control

When Modify Print File is set to Custom Options Only, you must add certain commands at the beginning 
and end of the custom options entries.

You must use one of the following structures for custom options:

• Use the following lines for custom commands for printer languages other than PCL files:

%!PS-Adobe-3.0
%KDKActOn:
[other DSCs and KDKs]
          .
          .
          .
%%EndComments

• Use the following lines for custom commands only when you print PCL files to the Network 
Imaging System Printer:

<esc>%-12345X@PJL
@PJL COMMENT %KDKActOn
[other DSCs and KDKs]
          .
          .
          .
@PJL COMMENT %%EndComments
@PJL ENTER LANGUAGE=PCL

where <esc> is the ASCII escape character.

Each line containing a DSC or KDK must begin with @PJL COMMENT followed by a space.
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Using the Paper Substitutions Tabbed Page

The Paper Substitutions tabbed page allows you to designate pages to be printed on paper other than the 
Body Paper.

The following is a list of features on the Paper Substitutions tabbed page:

Body Paper—Displays the body paper selected on the Job Setup 1 tabbed page.

Paper Substitutions List—Lists the specified substituted paper and pages.

Move Up—Moves a selected entry up one position in the Paper Substitutions List.

Move Down—Moves a selected entry down one position in the Paper Substitutions List.

Delete—Removes a selected entry from the Paper Substitutions List.

Paper—Specifies the paper to use for the indicated pages when you define a new paper substitution. The 
Paper Catalog definition for the selected paper appears in the field below the Paper drop-down menu.

Pages—Allows you to enter a list of page designations that indicate where to use the paper substitutions 
in the document.

Page ranges are expressed as two numbers separated by three (3) periods. For example, to express the 
page range “45 to 52,” type 45...52 in the Pages field. You can specify multiple page ranges as long as 
each one is separated by a comma or a space. Use a caret (^) to indicate that a blank page should be inserted.

The syntax for the Pages field is described in Table 3-2. Page numbers refer to the actual physical pages 
and may not relate to the document page numbers.

Table 3-2  Paper Substitution syntax

If you create more than one substitution for a particular page or range of pages, the Print File Downloader 
uses the paper substitutions specified in the list, starting at the top of the Paper Substitutions List.

Add—Moves a newly created paper substitution to the Paper Substitutions List. New papers appear at 
the bottom of the list.

Modify—Allows you to change the paper and pages for the selected entry in the Paper Substitutions List.

If you make changes to the Paper Catalog when you are on the Paper Substitutions tabbed 
page, you may need to refresh the screen in order for the Paper Catalog changes to appear.

To refresh the screen, click another tab, then click the Paper Substitutions tab.

Syntax Definition Example

n Indicates a specific page number. 45

n...n Indicates a range of pages. 45...52

n,n
n  n

Indicates more than one page number. 45,52
45  52

...n Indicates a range starting at the first page and 
continuing through to the specified page.

...45

^n Inserts a blank page before the specified page. ^45 

n^ Inserts a blank page after the specified page. 45^ 
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Printing Files

This procedure assumes that you have created a PostScript, PDF, or PCL print-ready file and that the Print 
File Downloader is open.

To print a file:

  1. Click the Printers tab.

The Printers tabbed page appears.

  2. From the Enable Printing Options for Printer Model list, select the Printer type.

A message appears stating that the settings may not be compatible.

  3. Click OK.

  4. If you are using a Windows system:

a. From the Installed Printers list, select a Printer or Printer port.

b. If your Printer is connected directly to a Network Imaging System Print Server, make 
selections in the Print Server group box.

If you are using a Macintosh system:

a. Select an AppleTalk zone.

b. From the Select a Printer list, select a Printer.

c. If your Printer is connected directly to a Network Imaging System Print Server, make 
selections in the Print Server group box.

  5. Click the Files tab.

The Files tabbed page appears.

  6. From the Select Files to Print list, locate and select the files you want to print. Verify that the 
selected files appear in the Files to Print list. Multiple files will be treated as separate job when they 
are sent to the Printer.

  7. From the Printer Language drop-down menu, select the printer language of your file(s).

  8. From the Modify Print File drop-down menu, select an option. For more information, see “Modify 
Print File” on page 3-4.

  9. Click the Job Setup 1 tab. 

The Job Setup 1 tabbed page appears.

Some Printers do not support all of the features.

If you select two or more files to print, they all must be of the same file type. You cannot 
print different types of files.

Macintosh systems can print only PostScript or PDF files.

The Job Setup tabs are only available if Modify Print File is set to Yes.
3-14 Print File Downloader for Windows® and Macintosh® Systems User’s Guide Release 4.5



Using the Print File Downloader
10. Make any necessary selections for the available features in the Job Setup 1 tabbed page. For more 
information, see “Using the Job Setup 1 Tabbed Page” on page 3-5.

11. Click the Job Setup 2 tab. 

The Job Setup 2 tabbed page appears.

12. Make any necessary selections for the available features in the Job Setup 2 tabbed page. For more 
information, see “Using the Job Setup 2 Tabbed Page” on page 3-9.

If you are not using custom options or paper substitutions, click Print to send the selected files to 
the specified Printer.

If you want to specify custom options or paper substitutions, continue with step 13.

13. Click the Custom Options tab.

The Custom Options tabbed page appears.

14. Make any necessary selections for the available features on the Custom Options tabbed page. For 
more information, see “Using the Custom Options Tabbed Page” on page 3-10.

15. Click the Paper Substitutions tab. 

The Paper Substitutions tabbed page appears.

16. Set up any necessary paper substitutions. For more information, see “Using the Paper Substitutions 
Tabbed Page” on page 3-13.

17. Click Print to send the selected files to the specified Printer.

You can click Print when any tabbed page is displayed to send the selected files to the 
Printer.

On Windows systems, to cancel a print request, press and hold [ESC]. On Macintosh sys-
tems, to cancel a print request, press the command and period keys simultaneously. You can 
only cancel a print request when there are multiple print jobs. The first job will print, but the 
subsequent jobs will be cancelled.

You will not be able to cancel a file that has already started transmitting to the selected 
Printer or Print Server. However, you will cancel the printing of additional files after the 
current file has been completely transmitted.
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Creating Shortcuts for Custom Settings Files

The Print File Downloader software does not automatically provide a method for specifying a default 
settings file to be opened each time the software is started. You can create a shortcut that will point to a 
settings file.

To create a shortcut for a settings file on a Windows system:

  1. Create a new settings file, if necessary. See “Job Settings Files” on page 1-6.

  2. Create a shortcut to pfdl.exe.

  3. Add the document settings file name as a parameter for pfdl.exe under the shortcut’s properties.

Using the Drag-and-Drop Functionality (Windows Systems)

The following describes the drag-and-drop functionality for the Print File Downloader on a Windows 
system.

• You can drag a settings file (.pfd extension) to the pfdl.exe icon to launch the Print File Downloader 
and open the settings file. This is the same as double-clicking on the settings file.

• You can drag a settings file to the open Print File Downloader application to open the settings file.

• If a settings file is part of a group of two or more files being dragged to the open Print File 
Downloader application, it is added to the Files to Print list and not opened as a settings file.

• If you drag print-ready files (document files that do not have a .pfd extension to the Print File 
Downloader, they are added to the Files to Print list on the Files tabbed page. If a file cannot be 
opened, an error message appears.

• You can drag files to the Print File Downloader from the desktop or any application that supports 
drag-and-drop, such as Windows Explorer.

• You can drag one or more files to the Print File Downloader at one time. If a single file in group of 
files being dragged cannot be opened, the other files will not be affected. If you drag two or more 
files to the Print File Downloader, they must all be the same language type.

If the Print File Downloader cannot open the Files tabbed page (because of an unfinished paper 
substitution, for example), the files are still added. The tabbed page will not change. 

Some options may not be restored.

If you are not familiar with defining a shortcut, see the user’s guide for your operating sys-
tem.

When you drag a settings file to the Print File Downloader, under some circumstances, the 
Mismatch Handling and Proof Set settings may not reset.
3-16 Print File Downloader for Windows® and Macintosh® Systems User’s Guide Release 4.5



Using the Print File Downloader
Resolving the Disk Full Error (Macintosh Systems)

If a disk full error occurs while you are printing from the Print File Downloader, you will have to manually 
delete the temporary Print File Downloader spool file.

To delete the temporary spool file:

  1. From the Desktop, select File →  Find.

  2. Search for a file that has the same file name as you were printing, with a “2” appended to its file 
name.

For example, a print file named diskfulltest.ps would have a temporary file named diskfulltest.ps2.

  3. Delete this temporary spool file.

Exiting the Print File Downloader

To exit the Print File Downloader from a Windows system:

  1. Select File → Exit.

If you did not save your changes, a window appears prompting you to save your file. If you saved 
your changes or did not make any changes, a window appears confirming your exit.

  2. Click Yes to save the file or to close the Print File Downloader.

The Print File Downloader closes.

To quit the Print File Downloader from a Macintosh system:

  1. Select File → Quit.

If you did not save your changes, a window appears prompting you to save your file.

  2. Click Yes to save the file.

The Print File Downloader closes.
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Section 4   Using the Paper Catalog
This section is intended for system administrators who will be manipulating the Paper Catalog. The Paper 
Catalog contains a list of paper names and their associated definitions, and can be password protected.

Accessing the Paper Catalog

The Paper Catalog allows you to manage the list of papers that are available for the papers in your print 
requests.

To access the Paper Catalog:

  1. From the Print File Downloader, select Catalog → Open Catalog.

The Enter Password window appears.

  2. Type the password.

  3. Click OK.

The Paper Catalog window appears.

Describing the Paper Catalog Window

The following is a list of features on the Paper Catalog window:

Papers in Catalog—Lists the names of papers that are defined in the catalog.

Move Up—Moves a selected entry up one position in the Papers in Catalog list.

Move Down—Moves a selected entry down one position in the Papers in Catalog list.

Delete—Removes a selected paper from the Papers in Catalog list. The default paper cannot be deleted.

Paper Definition—Contains the controls that define the paper that is highlighted in the Papers in Catalog 
list.

Paper—Displays the name of the paper being defined. You can change the paper name by typing a new 
name in the field. You can enter up to 16 characters in the Paper field. Valid characters include numbers 
0-9, all lowercase and uppercase letters (a-z, A-Z), and the characters # $ & * + . : = ? @ _ ‘ ~ .

Size—Defines the paper size for the new paper.

Color—Defines the paper color for the new paper.

When <<*>> is selected, a wild card is added to the color attribute. The jobs will print on the available 
paper, regardless of its color.

Weight—Defines the weight for the paper.

When <<*>> is selected, a wild card is added to the weight attribute. The jobs will print on the available 
paper, regardless of its weight.

Immediately after installation, you do not need a password to open the Paper Catalog. If a 
password has not been established, just click OK to open the Paper Catalog.

The first paper in the list is the default paper for all selections.

The following paper sizes now appear in the default Paper Catalog: 8 x 10, 8 x 10.5, 
8.5 x 10, 9 x 12, 9 x 14, 12 x 18, 14 x 17, 14 x 18, A4, A3, RA4, and RA3.
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Type—Defines a paper type for a new paper. Listed types are those defined in the Paper Catalog. You 
can add new types to this list by using the Edit Type List window described later in this chapter.

When <<*>> is selected, a wild card is added to the type attribute. The jobs will print on the available 
paper, regardless of its type.

Mode—When selected, the paper is forced to print 1-Sided, 1,2 Sided, or from the Inserter.

Add—Moves a newly created paper from Paper Definition to the Papers in Catalog list. New papers 
appear at the bottom of the list.

Modify—Replaces the selected paper in the Papers in Catalog list with the paper defined in Paper 
Definition.

Edit Colors—Allows you to edit the color of the selected paper.

Edit Weights—Allows you to edit the weight of the selected paper.

Edit Types—Allows you to edit the type of the selected paper.

Done—Closes the Paper Catalog window.

Adding and Modifying Paper Definitions

To create a new paper definition, you can select an existing paper definition from the Papers in Catalog 
list that is similar to the one you want to create, change the paper name, and define the Size, Color, Weight, 
Type, and Mode settings.

You can add names, colors, weights, and types to paper definitions if they do not exist in the Paper Catalog, 
but you cannot add sizes or modes. You must add a new paper name before you can add a new color, 
weight, or type.

Adding New Paper 

To add a new paper:

  1. In the Paper field, enter a new paper name.

  2. Enter values for the Size, Color, Weight, Type, and Mode settings.

  3. Click Add.

The new paper is added to the Papers in Catalog list.

The Paper Catalog saves the changes as you modify the definitions. You cannot undo 
these changes.

You can enter up to 31 characters in the Paper field. Valid characters include numbers 0-9, 
all lowercase and uppercase letters (a-z, A-Z), and the characters # $ & * + . : = ? @ _ ~.
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Adding and Changing Paper Colors

To add a new paper color:

  1. Click Edit Colors.

The Paper Color List window appears.

  2. In the Color field, enter a name for the new paper color.

  3. Click Add.

The new paper color appears in the list.

  4. Click Done.

To change the paper color of a paper definition:

  1. From the Papers in Catalog list, select a paper name.

  2. From the Color drop-down menu, select a different paper color.

  3. Click Modify.

The paper color is applied to the selected paper name.

Adding and Changing Paper Weights

To add a paper weight:

  1. Click Edit Weights.

The Paper Weight List window appears.

  2. From the Weights field, enter a new paper weight.

  3. Click Add.

The new paper weight appears in the list.

  4. Click Done.

To change the paper weight of a paper definition:

  1. From the Papers in Catalog list, select a paper name.

  2. From the Weight drop-down menu, select a different weight value.

  3. Click Modify.

The weight is applied to the selected paper name.

You can enter up to 16 characters in the Color field. Valid characters include numbers 0-9, 
all lowercase and uppercase letters (a–z, A–Z), and the characters # $ & * + . : = ? @ _ ‘ ~.

Do not use blank spaces in the new paper color name.

The <<*>> wildcard character will be displayed at the top of the Color drop-down menu.

The weight must be a numeric value between 60 and 200.

The <<*>> wildcard character will be displayed at the top of the Weight drop-down menu.
Release 4.5 Print File Downloader for Windows® and Macintosh® Systems User’s Guide 4-3



Using the Paper Catalog
Adding and Changing Paper Types

To add a paper type:

  1. Click Edit Types.

The Paper Type List window appears.

  2. From the Type field, enter a new paper type.

  3. Click Add.

The new paper type appears in the list.

  4. Click Done.

To change the paper type of a paper definition:

  1. From the Papers in Catalog list, select a paper name.

  2. From the Type drop-down menu, select a different type.

  3. Click Modify.

The type is applied to the selected paper name.

Deleting Paper Definitions

To delete a paper definition:

  1. From the Papers in Catalog list, select a paper name to delete.

  2. Click Delete.

The paper and its attributes are removed from the Paper Catalog.

You can enter up to 16 characters in the Type field. Valid characters include numbers 0-9, 
all lowercase and uppercase letters (a–z, A–Z), and the characters # $ & * + . : = ? @ _ ‘ ~ .

Do not include blank spaces in the new paper type name.

The <<*>> wildcard character will be displayed at the top of the Type drop-down menu.
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Creating a Custom Paper Catalog

You can create a custom Paper Catalog file to be distributed to multiple users.

To create a custom Paper Catalog:

  1. In the c:\<PFD> installation directory, make a copy of the pfdpaper.ini file.

  2. Rename the new file pfdpaper.old.

  3. Open the pfdpaper.ini file. 

The pfdpaper.ini file appears.

  4. Modify the Paper Catalog as needed.

  5. Save the pfdpaper.ini file.

  6. Copy the pfdpaper.ini file to a diskette. 

  7. Replace the pfdpaper.ini file with the new pfdpaper.ini file on the network file server that contains 
the installation files.

  8. Install the Print File Downloader with the new custom Paper Catalog.

Changing the Password for the Paper Catalog

If a password has been established for the Paper Catalog, you can change the current password to a new one.

To change the password for the Paper Catalog:

  1. Select Catalog → Change password.

The Change Password window appears.

  2. In the Old password field, type the current password.

  3.  In the New password field, type a new password.

  4. In the Confirm new password field, type the new password.

  5. Click OK.

The new password is verified and ready for use.

This procedure is for Windows systems only.

For Windows systems, the default installation path is c:\Program Files\company 
name\Print File Downloader\.

After installation, you do not need a password to open the Paper Catalog. If a password has 
not been established, just click OK to open the Paper Catalog.
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Glossary
Body Paper

The paper used to print all of the pages of a job, except those defined as Covers on the Job Setup 1 tabbed 
page and on the Paper Substitutions tabbed page.

Collate

Each copy of the document is printed in the correct, finished order.

Custom Printer Commands

Instructions for using Printer features that are not offered as Printer Driver controls.

Document

One or more pages, or a set of pages, that are grouped for consistent handling in the Printer. When not 
otherwise qualified, it is assumed to be the electronic form of a document that has been put in a file format 
that the Print Server(s) will accept.

Driver

Software that runs on the client computer and that interacts with applications to produce a print job. The 
job may be printed directly or saved as a PDL file. Drivers may also insert special job/page control 
information into the job. Drivers are developed for a particular operating system and Printer.

DSC

Document Structuring Conventions (Adobe Systems Incorporated). A set of commands placed throughout 
a PostScript language document that imposes an overall program structure. The products act upon some 
of these comments in the header of a PostScript language file to control Printer features and functions.

Duplex

Two-sided printing.

Job Settings Files

Sets of print options which specify whether files should print single-sided or double-sided, the paper and 
finishing options to use, and the number of document sets to print, etc. You can save these files and use 
them for future print jobs.

KDK Comments

Printer comments. Unique DSC comments specific to this product. All KDKs begin with %KDK.

Long-Edge-Fed Paper

Paper fed into the Printer with the longer dimension as the lead edge (for example, paper coming from 
the main paper supply, portrait letter paper, or portrait A4 paper).
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Maximum Signature Size

The maximum number of sheets allowed for a pamphlet. The maximum pamphlet size for all Printers, 
except the Network Imaging System Printer, is 120 pages (120 ÷ 4 = 30 sheets of paper). For the Network 
Imaging System Printer, the maximum pamphlet size is 999 pages (999 ÷ 4 = 250 sheets of paper).

Mini Pamphlet

A statement-sized (one-half of a Letter or A4 page) pamphlet.

Mismatch

A situation where a requested paper is not loaded, or where finishing options are requested and the optional 
finishing equipment is not installed.

Pamphlets

Documents printed with two images on each side of the page so they can be folded and stapled.

Paper Catalog

A list of defined papers that you can select to print jobs.

Paper Definitions

Descriptions of available papers which include specifications for size, color, weight, type, and mode.

Paper Substitutions

Paper other than the body paper. You can specify certain pages to be printed on a specific paper.

PCL

Print Control Language. Print-ready file format created by Hewlett-Packard Company for LaserJet, 
DeskJet, and RuggedWriter Printer lines.

PDF

Adobe Portable Document Format. A file format used to represent a document in a manner independent 
of the application software, hardware, and operating system used to create it. Introduced by Adobe Systems 
Incorporated in 1993 as the core file format for Adobe Acrobat.

PDL

Page Description Language. An interpretive programming language whose primary application is to 
describe the appearance of text, graphical shapes, or sampled images on printed or displayed pages. The 
description is high-level and often device independent. Examples of PDL include PostScript, PCL, PDF, 
and TIFF Group 4 Compressed.

PJL

Printer Job Language. A printer control syntax created by Hewlett-Packard Company comprised of human 
readable commands and one escape sequence (Universal End Language) embedded in the data stream 
for the purpose of controlling the job and Printer finishing of PCL jobs. PJL was developed to give software 
applications more job-level printer control, and to provide Printer status information to applications.

Postpended

Information provided at the end of a print job.

PostScript Language

A page description language that is device independent. Therefore, it is widely used on Macintosh and 
PC systems.
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PPD

PostScript printer definition file. A file that contains information about a particular Printer.

Prepended

Information provided at the beginning of a print job.

Print-Ready File

  1. An electronic document encoded in a PDL or a raster format (for example, TIFF).

  2. The queue of print jobs that are ready for the print engine to accept. At least one page will be in a 
format ready to be printed. Includes print jobs in the translating and translated states.

Print Server

A printing system server software which routes print jobs to available Printers.

RIP

Raster Image Processor. Hardware or software that prepares a file for a raster output device such as a 
Printer or screen.

Saddle Stitch

A finishing option where the document is folded in half and stapled in two places on the fold line.

Short-Edge-Fed Paper

Paper fed into the Printer with the shorter dimension as the lead edge (for example, 11 x 17 in. paper, A3 
paper, legal-size paper, transverse letter, or transverse A4 paper [landscape cassette]).

Simplex

One-sided printing.

Status Pages

Optional information sheet(s) printed after jobs to summarize the printing results.

Syntax

The format used for entering custom printer commands.

TIFF Group 4 Compressed

Tagged Image File Format. A specification for an image file format which allows the interchange of 
digital image data between different applications. TIFF describes attributes of an image, such as 
dimensions, orientation, and resolution. It does not describe where to place the image or how it is rendered.

Two-Sided Flip on Long-Edge

Printing is on both sides of each sheet such that you can view the back sides by flipping the sheets across 
their long edges.

Two-Sided Flip on Short-Edge

Printing is on both sides of each sheet such that you can view the back sides by flipping the sheets across 
their short edges.
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